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VDESK Touch Screen Camera Control Production Systems
USER GUIDE Version 7

Your VDESK Integrated Television Production System is designed specifically to enable a single operator to produce 
highly professional, multi-camera shows … with NO CAMERA OPERATORS REQUIRED. Name and save PTZ presets; 
create and display graphics and playlists; use multiple layers of crawls, logos and animation; use Chroma-key for 
virtual sets and backgrounds; encode to internal storage, stream LIVE, and much more. This Guide covers all the 
components and controls included with your VDESK system.

VDESK Hardware Overview
Your VDESK Touch Screen Production System is available in FIVE CHASSIS CONFIGURATIONS:

Features and functions are being added continually, and this Guide will be updated frequently.
As a result, the content herein may not reflect the current feature set and behavior of the application

You can connect a second monitor to display additional camera controls or for working with parallel applications like 
Adobe Photoshop Elements and Premiere Elements for creation or editing of on-screen graphics, and for editing your 
productions after they’re recorded.

Using Multiple Monitors

If you specify serial control for your VDESK configuration you’ll receive one or more 4-port MUX units which provide 
(RS422+12VDC) to the cameras, and a DEMUX for splitting power and serial at each destination. For NDI operability 
you can specify an 8-port GigE router.

ALL configurations include a custom keyboard with shortcut keys, mouse and 6 button Hall effect joystick.
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Input/Output Connectivity

VDESK PRO systems can be configured with
4 inputs, 8 inputs, or 12 inputs (SDI or HDMI), NDI inputs and output, and HDMI / SDI outputs.

RTMP streaming OUT

HDMI

HD/SD-SDI

PTZ cameras are controlled using VISCA RS422 serial protocol or VISCA over IP. 

The RUSHWORKS 4-port MUX connects to a USB port on the VDESK computer 

and sends 12VDC and 422 on four CAT5 cables. Power and serial are separated 

at each device with a DEMUX. The PTX Model 3 PRO uses VISCA over IP only.

MUX

Connect the USB output from an
audio mixer or analog-to-USB converter.

Inputs can be configured with

4, 8 or 12 HDMI, SDI and NDI sources.

SDI Out

HDMI Out

DEMUX

MUX

SDI / HDMI

VGA/HDMI/DVI
converter to SDI

(PowerPoint, Skype)

analog

USB

USB
RUSHWORKS MUX

CAT5 (DC power & RS-422)

CAMERA CONNECTIVITY / SERIAL CONTROL

Network

Ethernet switch

CAMERA CONNECTIVITY / IP & NDI CONTROL

DEMUX DEMUX DEMUX DEMUX

CAMERA CONNECTIVITY / VISCA over IP

CAT5 (DC power & RS-422) CAT5 (IP)

NDI

Streaming Host

Touch Screen
Monitor Computer

Keyboard
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NDI sources

NDI cameras

Joystick

System Device Connections
PTZ cameras
PTX pan/tilt heads
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Custom Keyboard Shortcuts

A custom keyboard with color-coded shortcuts is provided with your VDESK system. For an overview we’ll start at 
the top left and move down the main keyboard, then over to the arrow keys and number pad.

RED PGM1 – PGM12: Click these to select the corresponding 
switcher input to the PROGRAM window/output

GREEN PVW1 – PVW12: Click these to select the corresponding 
switcher input to the PREVIEW window

RED PROGRAM TAKE: Cuts to the current selection on the Preview 
panel. This action reverses the PGM/PVW selections on the 
switcher

GREEN SELECT CAM 5-8 on KEYPAD: Hold the Shift key and click 
any of the four green camera selection buttons on the keypad to 
select Cameras 5-8 instead of 1-4.

ORANGE TILT UP (Home): Tilt PTZ/PTX camera UP

ORANGE TILT DN (End): Tilt PTZ/PTX camera DOWN

ORANGE PAN L (Delete): Pan PTZ/PTX camera LEFT

ORANGE PAN R (PgDn): Pan PTZ/PTX camera RIGHT

ORANGE ZOOM IN (PgUp): Zoom PTZ/PTX camera IN (+)

ORANGE ZOOM OUT (Insert): Zoom PTZ/PTX camera OUT (-)
                                           

KEYBOARD CAMERA PRESET SELECTIONS

Q =  Preset 1
W = Preset 2
E =  Preset 3
R =  Preset 4
A = Preset 5
S =  Preset 6
D = Preset 7
F = Preset 8

KEYBOARD
GREEN CAM 1/5 – 4/8: Click once to select inputs 104 on 
the Preview panel. Hold Shift and press keys to select inputs 
5-8

ORANGE Number Pad (1-9): Select the corresponding Preset 
for the currently selected Preview camera

RED PGM AUTO (+): Dissolves from the PGM input to the 
PVW input

RED PGM TAKE (Enter): Cuts from the PGM input to the 
PVW input

BLUE File Brower (Insert): Selects File Browser window

BLUE Playlist (Insert): Selects Playlist window

KEYPAD

BLUE LIST (Up arrow): Select previous item (Playlist or File Browser)

BLUE LIST (Down arrow): Select next item (Playlist or File Browser)

BLUE DSK AUTO (Left arrow): DSK AUTO (fade ON or OFF)

BLUE DSK TAKE (Right arrow): DSK TAKE (cut ON or OFF)
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MASTER FADE

Software Overview – the User Interface
After powering up the system, run the VDESK software by double-clicking the VDESK launch icon on the 
desktop. After a few seconds the User Interface will appear. It will display the DEFAULT single screen layout.

The user interface has different panels and windows for controlling and monitoring most system functions.

Initial Setup:
If it is the first time you have run the application you’ll need to 
open the Configure panel and use the SWITCHER INPUT MAP to 
add your PTZ cameras, NDI sources and other input devices. 
Adding input devices and names will be discussed in detail in the 
following pages.

On the left side of the screen are the CAMERA CONTROL 
windows. The default number of camera windows displayed is 
four (Layout Template 1-1) but can be customized by an entry in 
the Config panel. The maximum number of inputs (PTZ or 
standalone cameras or other devices) supported by the system is 
twelve (12). The camera inputs can be configured for SDI, HDMI 
and NDI. Non-camera inputs are used for network sources such 
as NDI, Facebook, YouTube, etc. TWO window display sizes are 
available.

All camera windows function the same, but each controls a 
different camera. The camera output image displays in the 
window above the presets. There are eight (8) presets available 
per camera when using the CLASSIC interface. (The PRODUCER 
interface supports unlimited presets.) A larger camera panel can 
also be displayed by clicking the expand icon on the top right.

1 - Camera Input & Control Windows

2 - Preview Window
Beneath the PROGRAM window is the PREVIEW window. This displays 
which camera, clip or picture is currently on the Preview bus of the 
switcher. Use the motion controls and scrub bar to preview and cue up 
clips. A larger preview panel is displayed by clicking the expand icon on 
the top right.

click on icons to switch between display sizes

PTZ Camera Input
& Control Windows

Video Input Windows
(baseband & NDI)

File Browser

Playlist

Switcher

Preview

DSK

Master Audio

Clock

Program
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3 - DSK Window

5 - Playlist Window

4 - File Browser Window

6 - Program Window

To the left of the Preview window is the DSK window, which displays and 
controls images with transparency – usually PNG files.

This window has two sections, the DSK PREVIEW and DSK PROGRAM. This 
allows you to preview images while displaying another image keyed over the 
Program window. When the DSK Program is illuminated ("ON AIR") the image in 
that monitor will display on the main Program output monitor.

To the left of the PROGRAM window is the PLAYLIST window. 
This is where you save an ordered list of files for playback. Just 
drag and drop files from the File Browser to create and Save as 
many lists as you wish. Select and drag any item anywhere within 
a list to reorder the contents. Buttons are provided to change from 
Text View (TXT) to Icon View (ICO).

Click the PLAY ALL button to play all the files currently in a Playlist 
Window in the order they display. You can also launch the AUTO-
LOOP folder that repeats clips and graphics in standalone 
automation mode. 

Below the Playlist window is the File Browser window. This window 
allows you to browse for media on your system and select it for 
display. Quick access shortcuts are included for preset folders - CG, 
CLIP, PIC, and ALL- to help keep your media organized. CLIP and 
PIC images display in the PREVIEW window. CG images (typically 
‘lower thirds’ with transparency, i.e. PNG files) display in the DSK 
window. The File Browser window can also be sized vertically and 
horizontally.

You can locate files in a currently open folder using the Find entry 
field with the magnifying glass icon on the left.

On the upper right of the 
screen is the Program window. 
This displays the main video 
output of your system. On the 
left side of the video display is 
an icon bar where you can 
display (or hide) up to nine 
touch/toggle buttons, which 
are activated when selected 
with checkboxes in the 
Configuration/Options setup 
window.

Other functions on the Program Window include:

• CONFIGURE button
• RECORD setup and On/Off
• STREAM setup and On/Off

• HOT SHOT AUTO toggle rocker
• HOT SHOT TAKE toggle rocker
• AUTO KEY toggle rocker

• Currently loaded FILE name
• Currently loaded CLIP location and duration
• MASTER FADE button

Show Bug

Show Crawl 1

Show Crawl 2

Show Crawl 3

Show TXT

Show SNIPE

Show PIP

Show NDI DSK 1

Show NDI DSK 2

Program Overlays

File
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This window can be sized vertically and horizontally, and moved anywhere on the primary (or secondary) screen to 
accommodate your preferences.



7- Clock and Audio Windows

8 - Switcher Panel

To the right of the Program window are the CLOCK and AUDIO windows. They 
display the current time, a counter, and the level of the system's audio output. The 
slider is used to adjust the master volume. There is also a mute button which will 
completely silence the Program Audio output.

Click the SHOW AUDIO MIXER to open the full mixer panel overlay. Click again to 
HIDE the mixer panel.

Note: Since all the windows can be positioned and many of them sized, it’s often 
useful to have a second monitor to support overlay windows and keep your primary 
workspace uncluttered. You can name and save any number of these screen ‘layouts’ 
and recall them at any time.

Below the PREVIEW Monitor and DSK windows is the Switcher panel, displaying up to twelve 
inputs based on your system configuration. This controls which INPUT source is viewed on the 
Preview monitor, and/or sent to the Program OUTPUT.

The inputs can be a combination of PTZ cameras, video inputs, NDI sources, etc., and can 
be named/renamed by right-clicking the button and entering the text. 

The panel also has menu selections for Transitions and Effects. There are two file/clip 
players used to display video clips and graphics files. When active, the internal player number and status are 
displayed on the PGM (red) and PVW (green) buses. 

Click the AUTO button to make a transition between the PREVIEW and PROGRAM bus. Choose from three transition 
speeds: Slow = ½ second; Medium = 1 second; Fast = 2 seconds. Use the T-Bar for 
manual transition control. 

The optional VDX T-Bar Control Surface provides many of the integrated production 
functions in one versatile USB hardware companion.

• PTZ Camera & Preset Selection
• Pan, Tilt and Zoom Keys
• 13 PiP and Double-Box Preset Selections
• Wipe Transition Selections
• Chroma-key Selection
• Audio Mute Button
• Master Fade Button
• TAKE/AUTO Buttons
• T-Bar Transition Control
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The addition of new single monitor, dual monitor and wide screen monitor layout templates. 
Get started with a template you like that opens a New, Untitled Layout. Modify however you wish and then 
Name and Save the Layout in the Layouts folder.

Dual Monitor layout example

If touch screen operation isn’t important to you, a 49” 
curved wide screen monitor with a resolution of 3840 x 
1080 provides unlimited layout possibilities without having 
to deal with two separate 1920 x 1080 monitors. Here’s an 
example of a dual monitor layout on a Dell 49” monitor. 

Single Monitor layout examples
FILE BROWSER

PLAYLIST

PTZ CAM

SMALL

INPUT or

NDI SMALL

PTZ CAM

SMALL

PTZ CAM

SMALL

PTZ CAM

SMALL

INPUT or

NDI SMALL

PROGRAM

AUDIO

CLOCK

DSK

PREVIEW SMALL

SWITCHER

PTZ CAM

SMALL

PROGRAM

AUDIO

CLOCK

FILE BROWSER

PLAYLIST DSK

PREVIEW SMALL

SWITCHER

PTZ CAM

LARGE

PTZ CAM

LARGE

PTZ CAM

LARGE

INPUT or

NDI SMALL

NDI DSK 1

PTZ CAM

LARGE
PROGRAM

AUDIO

CLOCK

DSK

PREVIEW SMALL

SWITCHER

PTZ CAM

LARGE

PTZ CAM

LARGE

PTZ CAM

LARGE

INPUT or

NDI SMALL

INPUT or

NDI SMALL

FILE BROWSER PLAYLIST

CAM 1 CAM 2 CAM 3 CAM 4

PROGRAM

PREVIEW

DSK PVW

DSK
STAGE

NDI
DSK 1

NDI
DSK 2

QUICKSHOTS      SELECTION BUTTONS    AUTO/TAKE

CLASSIC

PRODUCER

Single Monitor layout example

Dual/Wide Screen Monitor layout example

CAM 1

CAM 2

CAM 3

CAM 4

STAGE

PROGRAM

PREVIEW

DSK PVW

DSK

NDI
DSK 1

NDI
DSK 2

QUICKSHOTS      SELECTION BUTTONS    AUTO/TAKE

FILE BROWSER PLAYLIST

CLASSIC

PRODUCER
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The Layout Template folder (D:\Layouts) contains read-only Layout templates for single, dual and super wide-
screen monitor configurations for both the CLASSIC and PRODUCER interfaces. In these folders there is a PDF 
showing the Layout Template proxies and their corresponding Layout Template number, e.g. DEFAULT, 1-3 or 2-5, 
where the first number is 1 or 2 indicating the number of monitors. Dual Monitor layouts are also appropriate for 
use with super-wide screen (3840x1080) single monitors.

There are several Layout Templates available to help you get started. Just click New Layout and 
the Layout Templates folder will open where you can review and select your layout preference. 
When the desired Layout Template is opened (using File Open or double-click), the corresponding 
Configure file is also created, matching the number and type of inputs in the Layout. When you 
click Configure… you can click on any of the input sources and change any items accordingly, as 
well as configure PTZ cameras and NDI sources. When complete you click Save or Save As to 
name and save the Layout in the Layouts/Classic or Layouts/Producer folders. An Untitled 
Layout or unsaved layout is indicated by an asterisk (*) in the Input 1 title bar. 

Creating and Managing Layouts



1 - PTZ Camera and Video Input Windows (Standard and Large)

Toggle the button in the upper right to switch between STANDARD and LARGE Input 
Display windows. You can position these windows anywhere on one or multiple monitors, 
then customize, name and save multiple layouts if you wish.

With TWO monitors configured you can size and position windows to maximize your 
efficiency and productivity in a session. Experiment with your Layouts to see what works 
best for you.

Camera/Source Input

Input Video Monitor

Overlay Link Indicator

Auto/Manual Focus Select

Focus Far/Near Rocker

Layout Name (on Input 1 only)

Panel Size Selector

Zoom Control

Preset Position Buttons

Software CCU Display

Activate / Setup Auto Zoom

Auto AE/Manual Iris SelectManual Iris Rocker

Configure Menu

Pan & Tilt Control

(Mouse down)

Panel Size Selector

Zoom Speed Up/Down Buttons
Enable SPEED Control for Presets

NDI DSK Input

Video Input 

Non-PTZ camera inputs 
show only the video 
signal. You can configure 
these on available 
hardware inputs or as 
multiple NDI camera or 
external source displays.

There are TWO NDI DSK 
inputs you can use to 
overlay transparent 
graphics from an 
external computer.
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2 - Preview Monitor & Control

The Switcher Preview window shows a video preview of the source selected on the Preview output of the switcher. 
This may be one of the PTZ cameras, another video input, or a preview of your clip playback or selected still graphic, 
if that graphic has no transparency. Typically BMP and JPG files do not support transparency. PNG files are most 
commonly used with transparency for ‘lower third’ titles and other instances where graphics are superimposed over 
a video source. These files display in the DSK window only, and are used for graphic overlays on the Program output.

When a clip is selected in the Playlist or File Browser it automatically appears in the Preview window and the 
appropriate transport controls become active.

The transport controls allow you to preview the clip, and cue the desired spot from which to start playback when the 
clip is selected for display on the PROGRAM output by clicking TAKE or AUTO on the Switcher. When a “LIVE” input 
or graphic file is selected the motion controls are disabled.

3 - DSK Preview & Program

The DSK window has controls for putting your graphics and video files on air. The monitor lets you preview graphics, 
and then fade or cut them over the PROGRAM video. When you click a graphic to display it in the DSK PROGRAM 
section, you can preview other graphics while the original is still on-the-air. Clicking "AUTO TO AIR" or "TAKE TO AIR" 
will fade or cut the graphic from the PROGRAM window then fade or cut in the second graphic from PREVIEW. 
Whenever a graphic is being displayed in the ON AIR DSK PGM window, or you can FADE it off (AUTO OFF) or TAKE it 
off (TAKE OFF) using the respective buttons below the ON AIR light in the PROGRAM section.

Clip Shuttle Control

Preview Input Display

Rewind -3x

1 Frame Reverse Play/Pause 1 Frame Forward

Fast Forward 3X

Clip Location Clip Duration

Clip Audio Level

Currently Selected Clip/File Name

Display of Image
over Program

Selected File Name

Preview of Selected File

ON-AIR Indicator

ON-AIR Controls

FADE ON current file
over Program

CUT ON current file
over Program

Click for Larger Display

Clear the graphic from PVW

GoToStart GoToEnd
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5 - Playlist Window

4 - File Browser Window
The File Browser window can be used for searching 
your hard drive to locate files to add to your playlist. 
There are four category buttons to take you to the 
default file types: CG, CLIP, PIC, and ALL, which 
shows all files at the root of your D: drive.

You can play and display files (CLIP • PIC • CG) 
directly from the File Browser simply by clicking on 
them and then clicking the TAKE or AUTO buttons on 
the Program switcher (for CLIP and PIC files) or TAKE 
TO AIR or AUTO TO AIR buttons in the DSK Preview 
window.

The Playlist window is used to create an ordered list 
of files for playback during your production. You can 
add files to the Playlist by dragging them from the File 
Browser. 

When you select a CLIP it will load into the Preview 
Window. Click TAKE or AUTO on the switcher panel to 
load and play the clip in the Program window. 

When you select a PIC it will also load into the 
Preview Window. Click TAKE or AUTO on the switcher 
panel to load and display the static the clip in the 
Program window.

When you select a transparent CG it will load into the DSK Preview Window, which is where files with transparency 
are previewed (PNG).  Click TAKE TO AIR or AUTO TO AIR in the DSK Preview panel to load and display the overlay 
on the Program window.

Files can be displayed as a simple text list (click the TXT button) or as thumbnails (click the ICO button). 

Resize the display from the bottom or from the right and place it anywhere on your monitor.

Files can be displayed as a simple text list (click the TXT button)
or as thumbnails (click the ICO button). Use the ICON SIZE slider

to customize your ICON display.

You can also use the custom keyboard shortcut 
functions to perform many of the program 
functions.

Trigger
DSK AUTO

Trigger
DSK TAKE

Select NEXT File
(File Browser/Playlist)

Select PREVIOUS File
(File Browser/Playlist)

Trigger
PGM AUTO

Trigger
PGM TAKE

Select
File Browser

Window

Select
Playlist
Window
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Click to open a New Empty Playlist

Click to open the D:/Media folder to select a file to add to the end of the list

Click to open the D:/Playlists folder to choose a previously saved Playlist

Click to Save the current Playlist, or use the Ctrl+S shortcut

Click to open the D:/Playlists folder into which you’ll name and save the Playlist.

Click the File Menu to view your Playlist choices



6 - Program Window

The Program Window shows the video output of the system. It is the final composited video signal that the 
system is producing. This is also what will be captured when you activate the RECORD and/or STREAM functions.

Bug On/Off

Bug Selection

You can display a LOGO BUG (usually a ‘branding graphic’) at any time by clicking once on 
the button. It will illuminate and the currently selected graphic, a PNG file, will fade on. Click 
again to turn off the LOGO BUG. The button returns to its inactive state and the currently 
displayed graphic will fade off. 

To select the graphic associated with the LOGO BUG, right-click on 
the LOGO BUG icon. Choose Select Logo Bug …  A browser window 
will open, revealing the contents of the CG folder. Select the desired 
graphic and click OK. When you next left-click the Bug icon to 
activate it, the attached graphic will fade on. 

Reset Logo Bug … removes the current bug file 
association, so nothing will be displayed with you click 
the Bug icon. 

Open File … opens the currently associated Bug graphic 
for verification

Click the GREEN PVW button to monitor PREVIEW through the computer audio jack output … 
and click the RED PGM button to monitor PROGRAM audio output – the same that is being 
output on the HDMI and SDI connectors of your system. Click the AUDIO MONITOR button to 
allow or mute the selected audio source (PVW, PGM) you’re monitoring. 

Audio Monitoring On/Off (Program or Preview)

When clicked, the RECORD and STREAM buttons wil highlight RED, indicating the processes are active. The titles 

will change to RECORDING and STREAMING. You’ll also see the running duration of the recording in progress. 

Click to STOP either function.
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VDESK supports three independent crawls: Crawl 1, Crawl 2 and Crawl 3. 
Click the associated tab to review/change your preferences for each.

VDESK ships with default parameters for all crawls. But you can change 
those at any time by clicking any of the three CRAWLS tabs on the 
Configuration page. Since there are a lot of display options to consider, the 
following descriptions focus on the four sections you’ll work with: SCREEN 
POSITION, FONT, MESSAGE FORMAT, and BANNER OPTIONS. 

The currently selected Crawl tab displays the associated Configuration page. 
As a design aid when creating and positioning the three crawls, you can 
check the preview boxes above the Crawl Preview screen to confirm all the 
crawl properties.

8

CRAWL Tabs

Note: There is an Emergency Crawl (white text on a red banner) that 
appears only when you enter and save text in the 
EmergencyCrawl.txt file. 

8

FONT SELECTION

Click the menu button to the right of the Name field. It will open the 

Windows Font selection panel.

Choose the Font, Font style, Size and Color using this menu. When you 

click OK, you’ll see the values appear in the respective fields in the 

Streamster FONT section.

SCREEN POSITION
These controls are used to position the crawl (text and banner) vertically on 
the screen. You can enter/modify the Offset from Bottom (default for Crawl 
1 is 15%), or you can click the Up and Down arrows to move the position. 
You’ll see the result in the Crawl Preview window. You can also use the 
keyboard Up and Down arrow keys to change the crawl position. 

Custom Color Selection

If you want to work with a wider range of color choices, click the menu 

to the right of the Color field in the FONT section. This window will 

appear, and you can pick from these Basic colors or click the Define 

Custom Colors button.

That expands the window to provide thousands of color choices, or let 

you enter RGB or HSL values to select a color.

You can Save that color by clicking the Add to Custom Colors button.

12



MESSAGE FORMAT
Set the Crawl Speed according to your preference. Message Spacing is the 
number of blank characters that appear between each line of text you enter 
in the Text Box when creating a crawl.

You can also add Text as a separator. To add a “Bullet” in addition to or 
instead of the Message Spacing value, click the Use Bullet • button to add it 
to the Text Message Separator. You can also enter any text or character 
value in that field.

 
 

To use a Graphic (usually a small branding logo) as a separator, click the Graphic radio button, then click the browse 
button to the right. Locate and select the PNG file you wish to use. Force ALL CAPS, when checked, changes mixed 
upper/lower case to all uppercase for your crawls. This automatically adjusts the banner height.
REVERSE Text & Direction, when checked, changes the crawl to Left To Right for use with several international 

character sets.

BANNER OPTIONS
Click the Background Banner checkbox to make it visible.

Select the Height of the banner, which defaults to the same size as the font 
you’ve selected (in percentage). To make the banner larger than the font, 
just enter a value greater than 100.

Click the browse button to the right of the Color display box to open the 
same Color picker used for the font, and make your selection.

Enter a value for the Opacity of the banner in percent. The higher the value, 
the less you can see the video behind the banner.

You can Indent the Left and Right Edges of the banner by entering a value representing a percent of the total 
screen width. You can also ‘soften’ the Left and Right Edges of the banner by entering a Fade value in pixels.

13
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1.Right-click the TEXT button on the Program Monitor and 
choose Edit Text…  The Text Properties window will open.

2. Click the Display Date/Time checkbox if you just want 
to overlay this information. Use the two radio buttons to 
specify if you prefer the Date or Time as the first line.

3. If the TEXT entry radio button is checked, enter one or 
more lines of text in the window. Click the Enter key 
whenever you want to start a new line of text. In real-time 
you’ll see the text in the Video Preview box, showing 
exactly how it will appear on the Program output.

Note: Use the text formatting entry fields in the FONT and 
TEXT sections to style the text how you wish. Use the radio 
buttons and nudge arrows in the SCREEN POSITION 
section to position text exactly where you want it for 
display.

4. As soon as you create text in the entry window, the 
TAKE to PGM button appears. Click that button and 
whatever is displaying in the Video Preview window will 
fade on the Program Monitor, and the Text Properties 
panel will close.

5. Click Choose Image to select a graphic to display 
behind the text, which is typically a ‘lower third’ overlay. 
The selected BG file name displays in blue, and the image 
displays in the Video Preview. Click the X to clear the file 
name/image.

6. To align the text over a background image use the 
SCREEN POSITION radio buttons for general vertical 
positions. Then use the nudge arrow buttons to position 
the text over the graphic. Click OK when you’re done. If 
you want to Save the composite graphic as a png file with 
transparency, click the Save PNG… button to open the File 
Name and Save dialog. It will be saved in the D:/Media/CG 
folder.

Edit Text… opens the TEXT composition and overlay window where you can 
customize individual text files by editing the parameters and position. This 
also makes it easy to alignin text over background images to create real-time 
lower-third graphics.

Configuring and Editing Text - “RUSHWORKS CG”

5. To display the text/graphic overlay, just left-click the TEXT button on the 
Program Monitor and the graphic will FADE ON the Program screen and 
the TEXT button will illuminate. Click it again to FADE OFF the lower third.
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If the TEXT list radio button is checked, an empty list 
appears below the text entry field. TEXT lists can be 
named and saved, and are very convenient for creating 
a list of names for participants in events such as city 
council, school board meetings and similar venues. It’s 
also another way to quickly access a list of song titles 
or scriptures for worship services.

Enter your text in the entry field. The Add to LIST 
button will display in yellow. Click that button to add 
the text to the List. When a new entry is added to a list, 
the Save button illuminates yellow. It will remain active 
unless/until you click it.

When you click the Save button a dialog will open the 
CG/TEXT LISTS folder where you’ll name and save the 
list. If the Save button is 
highlighted and you click 
OK, New, Open or the 
TEXT entry radio button, 
you’ll see a warning 
asking if you want to Save 
Changes to List? before 
completing the action. 
Select OK, Don’t Save or Cancel.

As with the TEXT entry screen you can Choose an 
Image to use as the background graphic for the items 
you save in a List. If you want to save the composite 
graphic and text overlay to use as a single CG item, 
click Save PNG… and the contents of the Video 
Preview will be saved into a PNG file. The name/save 
dialog opens the D:/Media/CG folder where you’ll save 
to the root of that folder or any subfolder(s) you create.

The currently active text is always highlighted in the list 
- and the currently loaded TEXT list name will also 
appear in blue under the list window.

When you click the Open button the CG/TEXT LISTS 
folder opens where you’ll select and load a saved list. 

If you have an event with several names you want to 
use during production, just right-click the TEXT button 
and select Edit TEXT to open the TEXT window, click 
on any name in the currently loaded list, then click the 
blue TAKE to PGM button and it will appear as on 
overlay on the Program Monitor. The Text Properties 
panel will remain open so you can place it anywhere on 
your monitor for immediate access to text. The FADE to 
PGM button works in tandem with the illuminated TEXT 
button on the Program Monitor. Click OK to close the 
TEXT panel whenever you wish.

Remember: When you click the TEXT button on the 
Program Monitor the items currently displaying in the 
Video Preview window on the Text Properties page will 
fade on. 

Creating & Using TEXT Lists



Using HOT AUTO, HOT TAKE and HOT KEY buttons

7 - Clocks & Audio Windows

The three HOT buttons provide enhanced automation of putting your selected 
preset shots on the Program output … as well as fading on any graphics 
associated with PTZ camera preset selection. HOT KEY only applies if you have 
created links to graphics for any of your presets (see “Linking a Graphic to a 
Camera Preset” on page 15).  

Toggle on/off either the AUTO or TAKE buttons. They will ‘illuminate’ when 
active/on. Whenever you select a “linked” camera preset, the system will 
automatically switch to that shot as soon as the camera reaches the preset 
destination, “cutting” to the shot if TAKE is On/illuminated … or dissolving to the 
shot if AUTO is on/illuminated.

With HOT KEY OFF, the system will automatically load the associated graphic 
into the DSK PVW window, where you can manually use the TAKE TO AIR or 
AUTO TO AIR to fade on that graphic over the PROGRAM video. 

With HOT KEY ON, the associated graphic will automatically fade on after the 
HOT AUTO or HOT TAKE is executed. Right-click the HOT KEY toggle to display 
user-defined settings for how many seconds it’s delayed before it fades on … 
and for how long it displays before it fades out. 

The clock window has an analog clock showing the current 
time. It also includes a digital clock and timer. To start the 
timer, simply click the button labeled "Click for Timer" and it 
will start counting up seconds. To stop the timer, touch the 
display. To start again, touch the display again. The "Reset" 
button will reset the display to zero.

The Audio Window shows the real time master levels of your 
VDESK system. These levels reflect what the system is 
outputting on the master audio output as well as what is being 
captured by the encode function. 

The Slider will adjust the mixed output of all the audio 
sources. 

The Mute button will mute the audio output of the system. 

The Close and Minimize controls on the clock panel affect the 
entire program. You can also exit VDESK by right-clicking any 
of the camera window title bars and choosing "Exit".

Close / Minimize

Analog clock

Digital Clock

Clipping indicator

Peak level indicators

Output level slider

Mute output

Show Audio Mixer Panel
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8 - Switcher Panel

The Switcher Panel displays the configured inputs on the Preview and Program bus. You can change inputs one of 3 
ways:

1.  Use the AUTO button - this will change between the Program input and the Preview input using currently    
selected transition and duration.
2.  Use the TAKE button - This will cut from the Program input to the Preview input.
3.  Direct selection - Click any of the input buttons on either bus to switch the corresponding bus to that input.

These allow you to control what happens when a clip on program reaches the end. The control 
is located above the CLIP1 and CLIP2 buttons on the switcher. When you click on the text it will 
cycle though the four choices, and when you click on the down arrow it will display a menu:

Clip End Actions:

Black at Clip End - Once the clip runs out you will see black until you choose another input on the switcher.

Take at Clip End - Upon reaching the end of the clip the system will perform a TAKE command, switching to the 
preview input.

Auto at Clip End - At the end of the clip the system will perform a dip to black transition.

Repeat at Clip End - The clip will repeat until another input is selected. This option lights up RED as a reminder - 
the clip will keep looping endlessly unless you stop it!

Transitions and Effects tabs:

The Transitions and Effects tabs are where you select the type of transition, duration of that 
transition, and effect options. Not all effects and transitions have the same options so each 
selection will look different.  

For more information on how to use these, jump ahead to Choosing Transitions & Effects.

DISSOLVE
PVW to PGM

CUT
PVW to PGM

Program Bus
Input Selection

Preview Bus
Input Selection

Clip end
Action

Transition &
Effects tabs

Slow • Medium • Fast
default transition speeds

Upstream
Effect

Current 
Selection

T-BAR
manual transition

dropdown list
of Transitions

dropdown list
of Effects
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9 - Audio Mixer Panel

Click the SHOW AUDIO MIXER button above the Program Audio Monitors to open the Audio Mixer Panel. 
This provides individual level monitoring and adjustment of the INPUT sources you’ve defined in the 
Configuration setup. The button label changes to HIDE AUDIO MIXER when the panel is open.

The RECORDING button above the PGM monitor also turns RED and 
displays the word RECORDING while active. The in-progress record 
timer is displayed above the button. Click the red button and the 
recording is stopped, with the button text reverting to RECORD in black.

If recording space drops below one hour you will see a pop up warning that 
will display again at 5 minutes remaining. Recording will STOP 
AUTOMATICALLY when no more space is available. Please keep this in mind 
when starting a recording, and don’t jeopardize your production by losing any 
of the content.

10 - Recording

When you click the RECORD Setup icon at the top of the 
Program Monitor the Record Settings panel will appear. 

To start recording, click RECORD. Whatever you see on the PROGRAM 
display is what you are recording.

You can click the PAUSE button at any time, and it will glow bright 
yellow – with the button label now displaying RESUME. Click the 
RESUME button and the file(s) will resume recording, creating a single 
seamless data file.

File name

12

You can record up to three (3) inputs 
as separate files while you are also 
recording your Program output and 
streaming.

Click the ISO Recording checkbox 
and select which inputs (up to 3)  
you’d like to ISO Record.

Bit Rate selector

Record PAUSE / RESUME

Recording path

Recording status Streaming status

Streaming setupRecording setup

** ATTENTION **

OK

Less than 1 HOUR of recording time remains. 
Recording will STOP automatically

when time expires.
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11 - Streaming Settings

This page displays all the information associated with your 
streaming setup and output parameters, as well as the status of 
your current stream when active.

Click the SETUP STREAMING button to enter the necessary 
information to configure your desired stream output. 

Click the STREAM Settings icon to open the Settings page.

Click the STREAM button to activate STREAMING. 
It will turn RED when streaming is in progress.

Although there are several parameters to enter on the Streaming 
Setup window, they are absolutely required when you’re setting up 
your streaming output. Since you’ll likely be delivering your signal 
to a Content Delivery Network (CDN), first select your provider by 
clicking the arrow for the dropdown. Your 
choices are ANYSCREEN™, 
RUSHWORKS’ subscription hosting 
service, YouTube Live, Facebook Live, 
Vimeo Livestream and Custom.

Copy each field from your CDN’s detailed settings page and paste 
into the matching field on the CONFIGURE STREAM window. If 
Video Bitrate and Audio Bitrate suggestions are not provided, then 
use the default values. Click OK when done.

Click the green START button to activate STREAMING. The 
STOP button will turn RED when streaming is in progress.

You can monitor the current Stream Duration, as well as a 
report of how many Source Drops and Encode Breaks have 
occurred during the session. The Buffers indicate the 
‘health’ of your bandwidth connection. The lower the 
number the better your performance will be.

19



Configuring Your INPUTS, OUTPUT and OPTIONS

This is the first thing you MUST do when you receive your system!

These procedures identify all the devices and connections you’ll be using in 
your productions, so setting it up correctly in the beginning is very important.

Depending on the VDESK model you’ve chosen the system will have Blackmagic SDI and/or 
Magewell HDMI input/output cards. You can identify up to 12 input video sources, which can be a 
combination of PTZ or non-PTZ cameras, NDI-connected sources (cameras, computers or other 
devices) or streaming URLs. You can also display TWO NDI DSK overlays.

Your system hardware configuration is preconfigured at RUSHWORKS prior to shipping. 
When you open the Configure window you’ll see the number of hardware card inputs 
available in your system. For example, if it’s a Decklink Duo 2 you’ll see FOUR inputs. If it’s a 
Quad 2 you’ll see EIGHT inputs. If its a Duo 2 and a Magewell 4-port HDMI card you’ll see 
FOUR Duo 2 inputs and FOUR Magewell inputs.

The Input matches the input displayed on your switcher panel buttons, left to right. 
The Input Connection defaults to Blackmagic cards and inputs first, followed by Magewell. 
The Name for each is sequential, defaulting to the same as the Input. 

When you click any Input row in the grid the Setup Input window will appear. Here you can 
select your desired Input Connection from the dropdown of available choices, enter a Video 
Source description, and create a Name that will replace the input number and display on your 
switcher panel.

Source:

Input:

Name:

DeckLink Quad 2 (1)

CAM1

News Center Cam
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Protocol:

Camera:

Interface:

Port:

Baud Rate:

If you’re configuring a PTZ camera on the selected Input, check the 

Configure PTZ Camera checkbox. The Setup Input panel will expand to 

reveal the setup parameters you’ll select using the dropdown lists.

The Name field is auto-populated based on the Input number clicked. 

(IN 1, IN 2, etc.). This can be overwritten here, or by right-clicking the 

switcher input and Renaming that input. The change is then reflected 

in this field and on the corresponding switcher button.

VISCA (Sony)

VISCA (Sony)
Panasonic
Canon

< select >

NDI

Source:

Input:

Name:

Source: STREAMSTER-2 (STREAMSTER-2) NDISource:

Input:

Name:

NDI

TOWR

38400

Port:

Protocol:

Interface:

Port:

VISCA (Sony)

Serial

4 Camera 1

38400Baud Rate:

Camera: Sony SGH-300

Input Input Connection Name Video Source Port

CAM 1

IN 2

IN 3

RW-510 COM 5

Click on any Input row. The Setup Input panel 

will open. It will display the information for the 

row you’ve clicked. This example indicates 

you’ve clicked on row 1 (Input 1) which has 

previously been assigned to the DeckLink Quad 

2 input 1. 

Source:

Input:

Name:

DeckLink Quad 2 (1)

IN 1

Source:

Input:

Name:

DeckLink Quad 2 (1)

IN 1

Use the dropdown lists for Protocol, Interface, Port and Baud Rate to select 

those that match the PTZ camera you’re connecting. Protocol defaults to 

VISCA (Sony) since it’s the most widely used for PTZ control. Then select the 

Interface, Port and Baud Rate, if/when applicable. 

This is a dropdown list from which you can also choose other options that will appear on the selected Input.

Camera:

Source:

Input:

Name:

DeckLink Quad 2 (1)

WCAM

Rooftop Weather Cam

If the video Source on an Input is NOT a PTZ camera, and NDI is NOT 

selected as the Input - enter an Input Source description and optionally 

change the Name that appears on the switcher button and SWITCHER 

INPUT MAP field.

Protocol:

Camera:

Interface:

Port:

Baud Rate:

VISCA (Sony)

<select>

<select>

<select>

DeckLink Quad 2 (1)

IN 1

Interface:

Port:

Baud Rate:

The Camera field is a read-only display that will automatically display 

the camera manufacturer and model after you click the Done button.

When NDI is selected as the Input the refresh button appears right of 

Source, and the first displayed item in the dropdown list is <select>.

When Serial Interface is selected you’ll 

use your 4-port MUX and connect up to 

four RS-422 sources by assigning a 

unique MUX port to each device.
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Click on the OUTPUT tab of the Configure menu. Here you’ll select your 
desired output parameters from the drop-down lists in each field:

. • Video Resolution
• Audio Mode
• Main Video Output
• Second Video Output
• NDI Output

Click on the OPTIONS tab of 
the Configure menu. Check the 
boxes you’d like active for your 
VDESK production sessions - 
including which of the nine (9) 
Program Overlay buttons you 
want to display on the 
Program Window.

IMAG Router Output with Reduced Latency

All digital production systems have latency in the program output signal. VDESK is no different, typically with a 
5 or 6 frame delay. This is enough to make in-room display uncomfortable for audience viewing. With VDESK 
you can control an external video routing switcher with minimal latency, automatically mirroring the VDESK 
Program input selection on the switcher using IP commands. The output of that switcher feeds the IMAG 
screen with only a couple of frames of delay. You lose any graphics overlays or transition effects, but the 
primary camera selection is always displayed on the IMAG screen.  

• Check Router Follows Program
• Select the Router Output #
• Enter the Router IP Address

Blackmagic Cleanswitch 12x12

Show Bug

Show Crawl 1

Show Crawl 2

Show Crawl 3

Show TXT

Show SNIPE

Show PIP

Show NDI DSK 1

Show NDI DSK 2

Program Overlays
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Using VDESK in Production

Setting, Naming and Saving PTZ Camera Presets
• Zoom Out

• Zoom In

• Tilt Up

• Tilt Down

• Pan Left

• Pan Right

Now that you have had a brief overview of each window that makes up the user interface, we’ll show you how to set 
up for production

The “How To” steps we will cover are:

1.  Configure the system components
2.  Create, name and save your camera presets
3.  Create graphics for your production
4.  Link a camera preset to a graphic
5.  Create a playlist
6.  Set up a recording

Once these things are done you are ready to start your production.

There are a few different ways to control the PTZ cameras. The 
joystick and touch pads are the most common, but you can 
also use these keys to adjust camera positions. The joystick 
and keyboard controls will always apply to the camera currently 
selected on PREVIEW. This allows you to move the camera to 
the position or preset you desire without a rapid on-air move. 

Use the joystick to position the shot using Pan, Tilt and Zoom - then right-click the desired preset button on the 
corresponding camera window. This will open a context menu for managing presets

Name and Save Preset…
Opens the Preset creation dialog. Enter a name and click OK to Save 
the Preset.

Save Preset           (position only)
No dialog is opened. It just saves the current position (XYZ) values.

Rename Preset…   (name only)
Opens the dialog where you change the name but not the XYZ values.

Link Preset to DSK Overlay
Opens a dialog that allows you to select a graphic (PNG file) to link 
with the preset. Each time you go to the preset the linked file will be 
loaded in the DSK window.

Go To Preset
Move the camera quickly to that preset

Copy Preset
Saves all the associated positioning and camera data.

Paste Preset
Pastes the copied positioning and camera data

Copy All Presets
Saves all positioning and camera data for all presets.

Paste All Presets
Pastes all the copied positioning and camera data from one camera to 
those on a different camera.

Clear Preset
Clears all data from the selected preset.

Clear All Presets
Clears all data from all the presets.
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Creating Graphics & Animations using Adobe Elements 

Note: if you choose to create your own graphics they must be on pages corresponding to your selected output format 
(480i, 720p, 1080i or 1080p). These are, respectively, 720x480, 1280x720, and 1920x1080.

Linking a Graphic to a Camera Preset

Once you have a camera position saved to a preset button you have the option 
to link an overlay to it. These can be created in Photoshop Elements or 
another graphics program you may have. 

Once these files are saved as PNGs you can link them. All you have to do is 
DRAG your PNG from the File Browser onto the preset button you want it 
linked to and then DROP it. The link icon will display on the button.
It's that easy!  Alternately, you can right-click the desired preset and select 
Link Preset to DSK Overlay from the list. 

For your convenience, VDESK PRO systems include Adobe 
Photoshop and Premiere Elements. For extensive guides please 
refer to each product's manual or to Adobe's website. There are 
many useful video tutorials to help you through all the different 
features of each program.

These programs are great for creating graphics of all kinds, 
including lower-third titles with transparency (PNG). You can also 
edit your productions, or any other production footage … so this 
added functionality provides you with enhanced capabilities on 
your VDESK system.

Premiere Elements         Photoshop Elements 

Check the box next to Link Preset to DSK Overlay and 
then the Link... button and browse to the graphic. 
Select it and click Open (or double-click), then click 
OK on the previous window. You will see the Chain 
Link icon. There are 3 states of this icon:

This link icon means that the preset is linked to a PNG and it is enabled. 
It will be loaded every time the shot is selected.

This link icon means that the preset is linked to a PNG and it is disabled. 
It will NOT be loaded when the shot is selected.

 This link icon means that the preset is linked to a PNG but the PNG can't be found.
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that to the TEXT button on the Program Monitor. 
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Saving Your Layout

Once you have linked everything you want be sure to save 
the layout. To do this, click on the ‘hamburger’ menu at the 
left of the camera title bar, or right-click on the camera title 
bar and select Save Layout (Ctrl+S) from the list.

Creating a Playlist
Creating a playlist for use during a 
production is drag and drop simple! 

Search for the desired files using the File 
Browser window and drag them to the 
Playlist window. You can select then drag 
and drop one or more files to change the 
order. If you want to save the playlist for 
later use, click the Save As button at the 
bottom. Playlists can also be created by 
importing an agenda from AgendaPrep.

• Select a single file by left-clicking on the file.

• Select multiple non-contiguous files by holding 
down the Option key while clicking on each.

• Select multiple contiguous files by clicking one 
file then holding down the Shift key while clicking 
the last file in the desired selection.

To Play a Selected File, click the TAKE or AUTO 
button on the switcher.

You can create and save as many Playlists as 
you wish. Saved titles should be short and 
descriptive and include the creation date. 
Here are some examples:

• City Council 071319
• P&Z 2021-07-19
• 7AM Service 07132021
• 11AM Service - July13

Selecting One or More Files in the 
File Browser or Playlist

Select Text
or Icon View

Button turns yellow
when changes are 
unsaved
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Right click the AUTO-LOOP folder to (1) Open the AUTO-LOOP Folder to view 
the contents, (2) check or uncheck the Play All Before Repeating function, 
and (3) check or uncheck the Random Order playback function.

Play All Before Repeating means that automation ‘remembers’ what has 
played in the AUTO-LOOP folder, and the next instance where AUTO-LOOP 
plays, files will resume in the order after the last played file.

If Random Order is checked, it will pick another previously unplayed file.

File Playback Automation using AUTO-LOOP
Looping the playback of a folder containing video clips is the easiest, quickest way for your VDESK to play 
continuous content with NO complicated user interface.

There is a folder called AUTO-LOOP at the root of your D drive (D:\AUTO-LOOP). Just copy clips into the AUTO-

LOOP folder.

File    Edit    Help File    Edit    Help

SUGGESTION: You may find it helpful to keep a shortcut to the AUTO-LOOP folder 
(D:\AUTO-LOOP) on the VDESK desktop so you can add or delete AUTO-LOOP files quickly.

AUTO-LOOP Options

Click the AUTO-LOOP folder button to enable it, and it will turn RED. 

An AUTO-LOOP PLAYLIST will pop up to the right of the standard playlist. 
When the contents of the AUTO-LOOP folder are playing, the individual 
files cue and play in order, appearing sequentially as indented playlist 
items under the AUTO-LOOP folder placeholder. The currently playing file 
is indicated in RED. The next file always cues seven seconds (:07) before 
it plays, and will be displayed as GREEN while it is cued.

Click the red AUTO-LOOP folder button to stop playback. The AUTO-LOOP 
playlist will close, and the switcher will return to the same status before 
AUTO-LOOP was enabled.

AUTO-LOOP PLAYLIST D:/Auto-Loop

AUTO-LOOP Playlist Display

AUTO-LOOP File Naming Tips
If you prefer to control the order in which the files and subfolders play, you 
can use standard Windows file-naming techniques to assign leading 
numbers to each of the content items. 

This example is a hierarchical arrangement for playback of files and sub-
folders in the AUTO-LOOP folder, and is based on a user-defined numbering 
structure. 

Note: Placing files in FOLDERS and SUB-FOLDERS is fine, which also helps 
you create specific content-based playback file groups. If you don’t use 
leading numbers, the system will use a typical Windows alphanumeric sort 
order for file/folder playback.

If you prefer to control the order in which the files and subfolders play, you 
can use standard Windows file-naming techniques to assign leading 
numbers to each of the content items. 

This example is a hierarchical arrangement for playback of files, sub-folders 
and various graphics in the AUTO-LOOP folder, and is based on a user-
defined numbering structure. Graphic files have a default duration of ten 
seconds (:10) which can be changed under the Edit menu > Set default 
Duration for Playlist Graphics.

You can override the default on individual graphics by adding a markup tag 
to the end of the file before the extension in [brackets], e.g. vincente[12].jpg, 
where 12 inside [brackets] indicates the duration, in seconds, that the 
graphic will display.

Note: Placing files in FOLDERS and SUB-FOLDERS is fine, which also helps 
you create specific content-based playback file groups. If you don’t use 
leading numbers, the system will use a typical Windows alphanumeric sort 
order for file/folder playback.

Rushworks

VDesk

Resource

Layout Templates

D:\Auto-Loop

Layouts

Classic

Producer

Classic

Producer

Ordered Contents of 
11 - HOLIDAY CHEER 2022
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PiP LOCK

HOT AUTO

HOT TAKE

HOT KEY

Disabled functions when AUTO-LOOP is active

There are certain functions that cannot be used when AUTO-LOOP is active. Others such as 
LOGO BUG, CRAWLS, SNIPES and TEXT are available at any time and will appear over the 
playing content.

The following are disabled and grayed out:

• all graphics EFFECTS, including the PIP LOCK button

• Switcher INPUTS (PREVIEW inputs remain selectable)

• Switcher TRANSITIONS (AUTO/TAKE) including the T-BAR

• HOT buttons (AUTO, TAKE, KEY)



Selecting and using Switcher TRANSITIONS

Selecting and Using Switcher EFFECTS

A video transition occurs between the inputs currently selected on the Preview and Program 
busses. When you click the TAKE or AUTO button the image on Preview replaces the one currently 
on the Program output

To view the available transitions, click the Transition tab and click the 
down arrow to display the dropdown list. There are 21 transition 
options to choose from. Dissolve is the default (AUTO), and is 
typically the most often used transition effect along 
with Cuts – which are 
accomplished using the TAKE 
button or by selecting various 
inputs on the virtual screen 
Program bus or using the 
keyboard shortcuts. 

The transition icons represent the 
type and direction of entry of the selected 
transition.

You can also repeatedly click on the transition name button and it 
will select and display the next transition in the order displayed on 
the dropdown list.

Because the switcher has only a Program and Preview Bus … plus a DSK (Down Stream 
Keyer) … the two busses are used to set up and display effects as well.

An “effect” is often called a “DVE” … or Digital Video Effect. This usually suggests the 
placement and/or manipulation of smaller video windows inside the ‘main’ video window. 
These types of DVE placements are referred to as “squeeze backs”, “PiP” (Picture-in-
Picture), “double box shots”, etc. 

Click the Effects tab and click the down arrow to display the dropdown list with the three available choices.

The VDX T-BAR Control Surface
The optional VDX Control Surface consolidates switcher Program and Preview selection, camera and preset selection, 
Playlist and File Browser manipulation, TAKE and AUTO Transitions, Effects and T-BAR transitions in one USB device. 
It’s a great way to provide one-button selection of almost any function without the need for a mouse.
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Display a Picture-in-Picture (PiP) using the Effects Tab
1) Select Picture in Picture in the Effects dropdown list.

2) Click the desired size and position from the six available choices. 
The small numbers in each box represent the input currently assigned 
to the PiP window and the background it’s displayed over.

3) To check or change the current input assignments, use the PIP and 
BG dropdowns to select available inputs for each. You’ll see your 
changes happen in the Preview window in real-time.

If you want to display a graphic in the PIP window, select File on the 
dropdown. Click the BG button to browse the D:\Media folder where you 
can select the graphic you want to display. Click the X to clear the 
selection.

Note: Each of the six PiP positions stores its own Foreground and Background input settings. Because all transitions and 
effects are confined to what can be accomplished using inputs on the PGM and PVW buss … plus the DSK … it’s important 
to learn how to manage the setup required for optimizing your results when using Effects in VDESK.

4) Click AUTO or TAKE to display the PiP effect on the Program screen.

Display a Double Box PiP …
1) Select Double Box in the Effects dropdown list. 

2) Click the desired size and position from the seven available choices.

You will see the currently assigned inputs in the respective box position icons. 
To change the current input assignments, use the L and R dropdowns.

4) Select the L (Left) input, the R (Right) input, and click the BG button to search 
for a Background Picture if you want to use one. You’ll see your changes happen 
in the Preview window in real-time. Click the X to clear the current BG selection.

Note: Each of the seven Double Box positions stores its own Box L and Box R input 
settings. Because all transitions and effects are confined to what can be 
accomplished using inputs on the PGM and PVW buss … plus the DSK … it’s 
important to learn how to manage the setup required for optimizing your results 
when using Effects in VDESK.

5) Click AUTO or TAKE to display the Double Box effect on the Program screen.

Toggle On/Off a Picture-in-Picture (PiP) from the Program Window
For simple one-touch PiP display of any input over any other input as background, this is a convenient way to operate.

When you open VDESK you’ll see NINE selection buttons for real-time activation and 
display. Right-click the PIP LOCK button and you’ll see the Configure PIP flyout.

This PIP Settings screen appears, providing 12 size, position 
and crop choices for the PIP. Click the image you want to use, 
then select the camera/switcher Input to display in the PIP 
window and click OK. When you click the PIP button it 
illuminates (BLUE = On) and the switcher panel shows a lock 
on the PIP input source. You can select any other source 
from the Preview bus and click AUTO or TAKE to display it 
behind the PIP, or just click an input on the Program bus.

PIP camera/switcher selection dropdown
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Then click the Adjust Chroma Key button. This setup window will appear, with the Foreground Input displayed. 

These faders control the most important values in creating a good key: Power, Transparent, Color and Smooth. 

Press the Auto Detect button and the current settings for these controls will be applied to the key, with the 

crosshatch pattern representing what the selected Background input or graphic will 

fill. If you check the Apply Instantly box, the adjustments you make will appear on 

this screen AND in the PREVIEW window of VDESK. 

Click the Advanced settings plus sign to extend the number and levels of control for 

creating the best key. Click the Apply button to see your changes, or check the Apply 

instantly checkbox to see the changes as you make adjustments. When you’re 

satisfied with your key, close this window, and click the TAKE or AUTO button to 

display the Chroma Key on the Program output.

Working with Chroma Key
Creating a good, “clean” Chroma Key depends a lot on the lighting. You should 
provide “flat” lighting across your green/blue screen, and good fill and back/rim 
light on your subject for optimal results. But the Chroma Key function in VDESK is 
extremely ‘forgiving’, meaning you can generally create high quality green screen 
keying without a lot of lighting … in some cases getting good results with simple 
overhead fluorescent lights!

Under the Effects tab select Chroma Key from the Effects dropdown list. 

The input numbers currently assigned for the background (BG) key 

subject (CK) are displayed on the icon. Change those in the dropdown 

lists to use the desired inputs. You can also select a File to use as the 

background by clicking on the File: icon and locating an image. You’ll see 

the changes in the Preview window in real-time. If you want to refine the 

key, click the Setup button.

Setting up a Chroma Key follows the same procedures as PIP/DVE 

effects. Choose your Foreground Input (the object in front of the Chroma Key screen) … and your Background 

Input, which can be a video input or a selected graphic file.

Chroma key in Preview Mode Chroma key on Program
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Setting up a Recording
When you click the RECORD Setup icon at the top of the 
Program Monitor the Record Settings panel will appear. 

The file path defaults to the "Recordings" folder on the D drive. If you enter a File Name 
(optional), that name will be included at the beginning of the file name. If not, the file 
name will be a timestamp as shown.

Under Program Recording use the radio buttons to select the format you want to encode. 
MPG is MPEG-2 CBR. H.264 is mp4. Select the Bit Rate you want to use for the recording. 
25 is a typical rate for MPEG-2 HD, and 12 is generally appropriate for H.264 HD.

To start recording, click RECORD. Whatever you see on the PROGRAM 
display is what you are recording.

You can click the PAUSE button at any time, and it will glow bright 
yellow – with the button label now displaying RESUME. Click the 
RESUME button and the file(s) will resume recording, creating a single 
seamless data file.

File name

Monitoring & Controlling Audio Levels
To the right of the Program Monitor is a real-time indication of your main 
audio level which is the level that will be recorded. 

Digital systems such as this are designed with -12dBFS as the optimal 
peak level. You will see the red OVER indicators light up if you go too far 
over this level. When they light up you will most likely experience audio 
clipping in your output and recording. If you wish to clear the red 
indicators simply right-click them. 

If your levels are too high or low, all you have to do is move the output 
slider up or down to compensate. It is a good idea to test your input 
levels against your CLIP 
playback levels before your 
production begins. This 
can be done on the AUDIO 
panel after clicking SHOW 
AUDIO MIXER.

Clipping indicator

Peak level indicators

Output level slider

Mute output

Show Audio Mixer Panel

12

You can record up to three (3) inputs 
as separate files while you are also 
recording your Program output and 
streaming.

Click the ISO Recording checkbox and 
select which inputs (up to 4)  you’d 
like to ISO Record.

Bit Rate selector

Record PAUSE / RESUME

Recording path

Recording status Streaming status

Streaming setupRecording setup
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Starting your Production

Once you have prepared your system for the production, review this list to 
make sure you are ready.

1.  Are all your camera presets set for this venue?
2.  Are the lower thirds and title screens ready and in your playlist?
3.  Are the lower thirds linked to the correct camera presets?
4.  Is your playlist saved?
5.  Is your layout (which includes camera presets) saved?
6.  Did you check your audio levels?
7.  Did you specify a file path for your recording?
8.  Do you have enough available record time for your program?
9.  Did you select the correct recording format?
10.   Did you name your file?

Don’t forget to start recording!
The first thing to remember when you are ready to start your 
production is to CLICK THE RECORD BUTTON!

The steps you take from this point on can vary greatly, but let's 
take a look at a typical city council meeting as an example.

1) Click the Recording Setup gear button. Enter a File Name 
for the Event you are recording.

2) Select MPEG-2 or H.264 as the recording format.

3) Verify the Bit Rate you want to use. The default for HD 
MPEG-2 is 35Mbit/sec. You can select between 12 and 50 
Mbit/sec. The default for H.264 is 12 Mbit/sec. You can select 
between 3 and 15.

4) Click the RECORD button to start recording. A record time 
indicator will appear in the bar above the RECORDING button. 
Click the RECORDING button again to stop recording.
 

Adobe Elements and VDESK 
For your convenience, VDESK PRO systems include 
Adobe Photoshop and Premiere Elements. For 
extensive guides please refer to each product's 
manual, or to Adobe's website. There are many 
useful video tutorials to help you through all the 
different features of each program.

These programs are great for creating graphics of 
all kinds, including lower-third titles with 
transparency (PNG). You can also edit your 
productions, or any other production footage … so 
this added functionality provides you with 
enhanced capabilities on your VDESK system.

Premiere Elements         Photoshop Elements 

Recording setup

32



Using the PRODUCER Interface 

PRODUCER Overview: Staging an Event
While the CLASSIC user interface is easy to use, the unique design of the PRODUCER touch screen user interface 
provides the simplest, most intuitive multi-camera production mode available. It’s based on creating and producing 
“Events” using a virtual on-screen 3D simulation of the physical environment where the PTZ cameras are located for 
each Event. 

Example locations include a meeting room, house of 
worship, radio station control room, indoor theatre, outdoor 
stage, or any other multi-camera production venue. 

The exclusive DoubleTake™ function lets you create an 
unlimited number of presets using a single PTZ camera, 
automatically assigning  those presets – with lens offsets – 
to a second camera, and go to any preset with either camera 
for instant coverage of any venue using just TWO PTZ 
CAMERAS.

You create the Event layout using five setup tabs:
 

• STAGE
• CAST
• PLACES
• CAMERAS
• PRESETS

Once the STAGE is set, you select shots by simply touching 
the picture or icon that represents the person or object at 
that physical place in the venue. You can then use the AUTO 
or TAKE button - or select HOT AUTO or HOT TAKE so the 
transition will happen automatically when the Preview 
camera reaches the preset.

For meetings these are typically pictures of meeting participants (picture icons = picons) in their respective seating 
positions. For houses of worship and theatrical events these are often a combination of picons and ‘musical icons’ 
(musicons™) such as a piano, guitar, drums, singers (tenor, soprano, etc.).
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The STAGE tab

In addition to simple ‘touch/take’ production, you can display any or all of the NINE effects available 
for selection on the PROGRAM monitor bezel at any time.

To change from the CLASSIC interface to the 
PRODUCER interface or the TalkingPoints 
interface, click the Configuration button, select 
the OPTIONS tab, and use the drop-down to 
select the Interface you wish to use. The 
program will automatically close, then reopen 
with the interface you’ve selected.

Click the File menu and select New Event. This opens a Save dialog 
where you will name and save the Event into an Event sub-folder. 

Click the Stage Setup button … then click the STAGE tab. There are 
several STAGE background templates to choose from, including the 
one(s) customized for your venue(s) prior to delivery of your 
VDESK/REMO system. Select the one that best represents your 
production environment.

Note: if you want to create your own custom background, use 
any graphics program to design it and save it as a JPG, BMP or 
PNG file and place it in the STAGE LAYOUTS folder. We’ve 
included an empty stage to use as a background for custom 
designs. If you wish to make a completely custom design the 
dimensions MUST be at least 800 x 400 (pixels).

Some of the included Layout templates for Houses of Worship, municipalities, entertainment and news

RUSHWORKS prepared this custom Layout
for the City of The Colony in Texas.

Stage Setup

Select Stage File: D:\RUSHWORKS\Stages\HOW Stages\HOW Contemporary 2 - 2 x IMAG Screens

Select your STAGE file by clicking once on the browse button      to open the STAGES folder. Here you’ll see large 
icon views of the STAGE background templates, organized into sub-folders for DAIS, HOW (House of Worship) 
NEWS, THEATRICAL and CUSTOM. There is an EMPTY.png you can use if you don’t want to use a graphic for the 
STAGE.
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The CAST tab

Next click the CAST tab. Here you will:

• Assign a picture icon (Portrait) for each preset
• Enter a Name and Title
• Select a graphic banner background for the name and title
• Enable “over the shoulder” (OTS) presets for the CAST member. These are typically used in a news-style 

presentation where the camera pans slightly left or right to allow for positioning of a graphic on screen with the 
person in the shot

Start by clicking the Add New button … and the associated entry fields will appear. In the NAME and TITLE fields enter 
the Name and Title of the CAST member (e.g. Roger Thomson and Council Member – or St. Anthony Chancel Choir 
and Sopranos). Note: NAME and TITLE fields are not required. Enter none, one or both.

To the right of the BANNER field click the File browse button to open the BANNERS folder. There are several banner 
templates to choose from. Select the graphic background you want to use behind the Name and Title display. 
NOTE: these will automatically be composited into files that are linked to each CAST member preset for manual or 
automatic display when the preset is touched/selected.

Under PORTRAIT, click the silhouette button of the CAST 
member. This will open the PORTRAITS folder within your 
currently open Event where you store pictures of Event 
participants. Double click on the picture you want to use – or 
select the picture and click Open. The picture will replace the 
silhouette. If you work with multiple Events (e.g. COUNCIL, 
P&Z, etc.) there will be a unique PORTRAITS sub-folder within 
the saved and named Event sub-folder. 

NOTE: The PRODUCER interface allows you to capture 
pictures for CAST members using any of the PTZ cameras 
configured with the system. If you want to create pictures in 
that manner, don’t click the silhouette under PORTRAITS when 
you’re defining CAST members. When you create your presets 
on the PRESETS tab you can capture a picture with your PTZ 
camera that will be associated with the already created CAST 
member. It will place the capture in the PORTRAITS sub-folder 
with the appropriate name, and also display it in the CAST tab 
whenever opened

To add another CAST member, just click the Add New button beneath the last added member. Follow the procedures 
described above until all the CAST members are defined, then click the Save button to save your information but not 
close the Stage Setup panel. Click the Close button to close the Stage Setup panel if you don’t want to do additional 
entry or modification using the Stage Setup tabs.
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The PLACES tab

Changing the SIZE of display picons

Adding EXTRAS to the STAGE layout

Once all the CAST members have been defined, click the 
PLACES tab. 

All the defined CAST member picons will be displayed across 
the top of the STAGE layout in the order in which they were 
created. Select each picon and drag it to its appropriate place 
on the STAGE.

You can choose from three (3) display sizes: Small, Medium and Large. The 
default size is small. To change the size of ALL the picons on the STAGE: 
double-click anywhere on the STAGE and they will all be selected, as 
indicated by a red outline on each picon. Then click another SIZE radio 
button and they will all display in the selected size.

To change the size of individual picons on the STAGE: click once 
on any picon to select it, as indicated by a red outline. Then click 
another SIZE radio button and only that picon will display in the 
selected size.

“EXTRAS” are defined as presets without unique pictures, names, titles or 
banners. These are typically used in theatrical and/or musical 
presentations and for houses of worship.

We’ve created a folder with dozens of icons that are representative of 
these types of presets, including musical instrument and performer icons 
(musicons) as shown here.

In the PLACES tab, click the Add Extras button. A folder will open, 
revealing all the Extras picons. Just double-click a picon to place it on the 
STAGE … or select it and click Open. 

To add multiple EXTRA icons, hold down the CTRL button and right-click 
on the ones you want to add, then click Open.

As you select Extras they will display horizontally across the top of the 
STAGE layout. You can then drag them to their appropriate position(s) on 
the STAGE.

To REMOVE an Extra picon, just select it and click the Remove Selected 
Extra button. It will disappear from the STAGE layout.
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The CAMERAS tab

The PRESETS tab

The system recognizes how many PTZ cameras are configured (via RS-
422 or IP) when the program is started. When you click the CAMERAS 
tab, you see the STAGE layout with CAST members and extras … and a 
row of configured PTZ camera icons at the bottom left of the STAGE 
layout. Drag each camera to its relative position on the STAGE. This 
establishes the association of the physical camera location relative to 
the CAST members and Extras.

You can mix “manned” cameras (non-PTZ) and PTZ cameras. They will 
display on video input windows and can be selected on PVW or PGM by 
using the F keys F1 – F8 (PGM), keyboard number keys 1-8 (PVW) or 
shortcut keys on the keypad. F9 and key 9 always select BLACK on PGM 
and PVW, respectively, on the switcher. The joystick will always control a 
PTZ camera that is currently selected on the PREVIEW bus. 

After you’ve selected your STAGE background, defined the CAST 
members, dragged the picons to their PLACES, and positioned the 
configured cameras, you’re ready to create PRESETS for each of the 
CAST members on the stage … as well as for any EXTRAS you may 
have placed. Additionally, you can create random presets that are 
associated with the QUICKSHOT buttons at the 
bottom of the screen.

Note: any picons that do not have a PRESET saved 
will display this overlay warning, reminding you to 
create that preset:

To create a preset for a CAST member or 
EXTRA …

Click once on the camera (icon) you want to 
associate with the shot. That camera will highlight 
RED. Then click the CAST member or EXTRA on the 
STAGE. The Adjust Camera window will open and 
the selected camera’s output video will be 
displayed.

Using the joystick (or the PTZ buttons on the 
PRESETS camera window), frame the shot the way 
you want it stored. You can also capture the framed 
shot as the graphic to use as the Portrait in the 
CAST tab and for picon screen display.

Click the Capture and Update Picture button to save and store the snapshot as the Portrait for that CAST member. 
Or click the Save Preset button to store the preset but NO picture. Click the Close button at any time to close the 
PRESET window.

You’ll click the ALIGN> button to set up the relationship between two cameras in a DoubleTake setup, which is 
discussed in the following section. 
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This mode follows standard Preview/Program switcher protocol, with each of the cameras always displaying on either 
Preview or Program bus of the software switcher. The camera currently on the Program 
bus is outlined in RED … while the other camera is outlined in GREEN.

To display the cameras properly and enable this mode, on the CAMERAS tab drag 
Camera 1 to the position where it and Camera 2 will be located next to each other. Then 
click the Enable Camera 1-2 DoubleTake checkbox. The Camera 2 icon will automatically 
jump to the immediate right of the Camera 1 icon.

Enabling and Using DoubleTake™

Setting up the DoubleTake™ offset

The DoubleTake function lets you create an unlimited number of presets 
that are duplicated between two PTZ cameras which are mounted 
closely together – either horizontally or vertically mounted – with the 
minimum distance between the lenses. 

On a 4-input system you can create TWO pairs of DoubleTake cameras 
(1-2 and 3-4).

The example on the right illustrates the type of ‘blanket’ coverage you can 
achieve with DoubleTake camera pairs. Typically there would be one pair of 
DoubleTake cameras at the rear of a room venue, and another pair on the 
wall behind a dais at the other end of the room for maximum coverage of 
the venue.

This shows the PREVIEW (Green) / PROGRAM (Red) relationship between the
DoubleTake camera pair on the STAGE and the camera video monitor windows.

If you’ve checked the Enable Camera 1-2 DoubleTake checkbox on the CAMERAS tab, you’ll always use the lowest 
number in the pair to set your presets for the two cameras. With a single pair of DoubleTake cameras, you’ll always 
use Camera 1. 

NOTE:  When you click Camera 1 or 2, they will BOTH turn RED, 
indicating they are a DoubleTake pair. If you enable a second pair 
of DoubleTake cameras, they will be Camera 3 and 4. So you’ll 
always use Camera 3 to set presets for that pair.

With the DoubleTake checkbox checked, click on Camera 1, and 
then click on a CAST member or EXTRA. The PRESET camera 
window will open and the selected camera will move to its 
“Home” pan-tilt-zoom position (presuming you have not already 
created any presets).

NOTE: It’s best to choose a CAST member or EXTRA in the middle of the STAGE when you’re setting up the secondary 
camera offset. This is generally a one-time-only exercise so you’ll want to trim the offset to a single area of the stage. 
The Horizontal and Vertical offset will be applied to the secondary camera for ALL presets on the STAGE. 
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For example, using Camera 1 to create all your presets for a 1-2 DoubleTake pair, the program automatically saves all 
the defined presets to Camera 2 as well, calculating the offset in the X and Y (horizontal and vertical) axes between 
the two cameras. It also stores the same Z (zoom) value, which means that either camera can go to any preset 
you’ve created. There is no limitation on the number of presets you can create for any camera.



Using the joystick (or the PTZ buttons on the PRESETS camera 
window), frame your shot then click the ALIGN>  button on the camera 
window. The window will expand to reveal a second camera window 
which displays the DOUBLETAKE Camera.

Camera control is immediately assigned to Camera 2. the 
DOUBLETAKE CAMERA. Using the PRIMARY CAMERA as the reference, 
match the framing of the DOUBLETAKE CAMERA as closely as 
possible. You can click on the Camera 1 and Camera 2 buttons in the 
box called VIEW ON PROGRAM OUT. Watch your PROGRAM monitor as you cut back and forth, and match the shots 
as closely as possible, making small adjustments on the DOUBLETAKE CAMERA. When complete, click the Save 
Offset button and then the HIDE> button to close the alignment panel.

NOTE: These OFFSET parameters are Global … meaning that they apply to ALL presets on the 
STAGE that were created by a set of DoubleTake cameras. Because of different angles relative 
to the two cameras, some DoubleTake preset offsets will be more accurate than others. In 
general, if you frame the tightest shots as Medium Close Ups (MCU), you’ll be happy with the 
results. The wider the shot, the less offset you’ll see between the two cameras.

Saving PRESETS to the QuickShots Button Bar
Below the STAGE area are ten (10) large red buttons. These are 
used for “general purpose” presets that are often convenient to 
have, but which don’t correspond directly to a CAST member or 
other picons on the STAGE. These are called QuickShot buttons.

To name and save a PRESET to a QuickShot button … select the 
PTZ camera you want to use for the shot, then use the joystick 
to position the camera where you wish. 

Right-click a QuickShot button and a list menu will appear. 
Choose the option that applies to what you want to accomplish. 
Typically you will Name and Save the shot you currently have 
framed in either the PREVIEW or PROGRAM window. 

The Name and Save dialog box will open where you can enter a 
name for the preset. When you click OK, the window closes, and 
you’ll see that name displayed on the QuickShot button.

If you select Rename and Store … the dialog is a bit different, 
suggesting you Enter a new name for the Preset, along with 
giving you the option to Link a Preset to the DSK Overlay.

You can click the Link… button to open the CG folder to find the 
file you want to overlay. Whenever the checkbox is checked and 
the preset is selected, the selected graphic will load into the DSK 
window and will automatically fade on and off in the Program 
window.

Another easy way to Link a graphic to a QuickShot preset is 
simply to drag the graphic from the CG folder onto the 
QuickShot preset. The link icon will appear and follow the same 
rules as described above.

Selecting any of the QuickShot buttons follows the same rules 
as presets associated with picons. You can switch between and 
among CAST picons, EXTRAS and QuickShots whenever you 
wish.
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Copy Preset

Paste Preset

Copy All Presets

Paste All Presets

Clear Preset

Clear All Presets

Rename and Store PGM Preset…

Store PGM as Preset

Rename and Store PVW Preset…

Store PVW as Preset

Rename Preset…

Go To Preset



User Interface Managment on the QUICKSHOT Button Bar

SHOW/HIDE the AUDIO MIXER

Using the DSK control

On the right side of the QuickShots button bar are additional buttons for controlling select functions on the 
PRODUCER interface. You can customize the way you work by showing or hiding different windows whenever you 
wish. 

The SAFETY SHOT zooms your DoubleTake PREVIEW camera full wide as a cover shot. If you have HOT TAKE or 
HOT AUTO enabled then the SAFETY SHOT will automatically go to Program.

Click MASTER FADE to take all current sources, DSK overlay, graphics overlays and audio to BLACK. While in this 
state, the button will flash once every second to remind you that you need to click it again to resume your 
PROGRAM output.

Illuminated toggle buttons are available for the  SWITCHER, PREVIEW, DSK, FILE BROWSER and PLAYLIST. The 
button will glow blue when the window is open/active. Just click any button to display the associated window, and 
place it anywhere you wish. The location will be saved in your current Layout.

Click AUTO or TAKE to initiate the currently assigned transition between the PREVIEW and PROGRAM busses. 

To display and use the AUDIO MIXER, 
click the SHOW AUDIO MIXER button 
above the Master Audio Fader. The 
Mixer window will open, where you can 
control the audio levels of your 
configured inputs, clip playback and the 
SNIPE audio level (if the Snipe file 
contains audio). When it is visible, you 
can place it anywhere on the screen … 
or on a secondary monitor if one is 
connected. To close the AUDIO MIXER, 
click the HIDE AUDIO MIXER button. 

The DSK control in PRODUCER is the same as the one in the CLASSIC interface. In either the File Browser or a 
Playlist, click on any file with transparency (PNG) … typically a lower-third graphic … and it will load into the DSK 
window. 
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To display the file over the current PROGRAM selection, click the DSK button. The 
graphic will fade on and the DSK button will glow bright blue, and the ON-AIR sign 
will illuminate. Click the button again to fade off the image.

Refer to the DSK section of the CLASSIC interface on Page 9 for more information.

Additionally, the following sections are included on pages in the CLASSIC section of 
the USER GUIDE:

Selecting Transitions
Selecting and Using Effects
To display a Picture in Picture …
To display a Double Box (PiP …
Working with Chroma Key



SUPPORT AND TECHNICAL ASSISTANCE FOR RUSHWORKS SYSTEMS

ARE AVAILABLE VIA EMAIL, TELEPHONE, LOGMEIN AND SKYPE

VDESK™ is a RUSHWORKS Technology Innovation

Software and Graphic User Interface Design
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SUPPORT@RUSHWORKS.TV 888.894.7874  OPTION 2

REMOTE TRAINING SESSIONS USING ZOOM, TEAMS OR SIMILAR CONNECTIVITY TOOLS

ARE AVAILABLE FOR SCHEDULING IN ADVANCE
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